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https://www.kitware.com/analyzing-ensembles-of-curves/

Outline

e Kitware

@ Introduction

e Basic Usage

e Visualizing Large Models

@ Topics for Future Exploration

Volumetric Rendering in VTK and ParaView:
Introducing the Scattering Model on GPU
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Kitware

e Open-source, software R&D company
e Core areas of expertise
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Kitware — HPC and Visualization

vrK Jll Paraview © CMB tomviz LidarView i 233) Trame
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Computer Vision and Al
Data and Analytics
Medical Computing
Software Process (cmake)
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To Follow Along...
Install ParaView 5.13.1
e hitp://www.paraview.org/download
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http://www.paraview.org/download

Introduction
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What is ParaView?

@ Anopen-source (BSD 3 Clause License), scalable,
multi-platform visualization application based on VTK
@® Processing paradigms:
e distributed computing (MPI)
e shared memory multiprocessing (SMP)
(vtkSMPTools)
e GPU processing (viskores).
@ Has an open, flexible, and intuitive user interface
@® Has an extensible, modular architecture based on open
standards
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ParaView on the Desktop

File Edit View Sources Filters Tools Macros Help

P& BRwaF? [@KNE L% KAD> DB mwme[ 5[
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Pipeline Browser BX (SE[E]E]

T
@ builtin:
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@

Object Inspector @
| properties | Display | information |
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Vectrs M——
Glyph Type 2D Glyph &
~E-2D Glyph
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[] Filled
Center [0 o [o )

Giyon Tanstorm

Transform2
%] Orient

Scale Mode vector =5

Set Scale Factor  [0.00514700851269389 ] ] et
{ Number

of Points l 5000

[%] Mask Points
% Random Mode E
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ParaView on the Web

Visualizer, Glance (vtk.js)
https://blog.kitware.com/vis-on-the-web/
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https://blog.kitware.com/vis-on-the-web/

./
ParaView Scripting - Python

Tools > Start Trace
___build a pipeline
Tools > Stop Trace
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ParaView Immersive and VR

OpenVR, OpenXR
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Y
ParaView for HPC
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ParaView Catalyst - Insitu Solution

B Picien 440228 A1 500

28 R RN L) >

Uses Conduit Blueprint
data description
e No need to compile
ParaView
e No need to recompile
when ParaView
version changes

Simulations with Catalyst: PyFR, HPCMP CREATE HELIOS,
PHASTA, MPAS Ocean, VPIC, RAGE, UH3D, CAM
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ParaView (VTK) Data Types

Uniform Rectilinear Non-Uniform Rectilinear Curvilinear
(vtkRectilinearData) (vtkStructuredData)

e Partitioned Dataset
e Partitioned Dataset

Collection
* Adaptive Mesh
Polygonal Refi COAMR
AW (vtkPolyData) Unstructured Grid etinement ( )
\< kitware (vtkUnstructuredGrid)
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ParaView (VTK) Cell Types

@ Cell types (linear, nonlinear), interpolation

@ Arbitrary order Lagrange Finite Elements

@ Discontinuous Galerkin elements and other novel
cell-types/function-spaces
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https://examples.vtk.org/site/VTKBook/05Chapter5/#54-cell-types
https://examples.vtk.org/site/VTKBook/08Chapter8/#82-interpolation-functions
https://www.kitware.com/modeling-arbitrary-order-lagrange-finite-elements-in-the-visualization-toolkit/
https://discourse.vtk.org/t/discontinuous-galerkin-elements-and-other-novel-cell-types-function-spaces/9209
https://discourse.vtk.org/t/discontinuous-galerkin-elements-and-other-novel-cell-types-function-spaces/9209

More Information

Z| Getting Started with ParaView

o

ParaView Guide F1

Reader, Filter, and Writer Reference

Il
Il

ParaView Self-directed Tutorial
ParaView Classroom Tutorials
Example Visualizations
ParaView Web Site

ParaView Wiki

ParaView Community Support
Release Notes

Professional Support
Professional Training

Online Tutorials

Online Blogs

Bug Report
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Basic Usage
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User Interface

Menu Bar

Toolbars

8 File Edit View Sources Filters Tools Catalyst Macros Help MmO« 2 100% @ Mon215PM Q =
eoe M ParaView 5.1.2 64-bit

PP BE ®»a 2 F O KA D> DD G T o |z

W - ;) }_Ca\ o ToxtureCoords [ Magnitude Surface With Edges [ B s 28 & oty a2 %o 79? w G =
EOO0 DR POE20 6 L& i x

Pipeline Browser ~—

Information Panel —
Properties Panel —
e Properties
e Display

o \View

Pipeline Browsor

HenderViewl 1 & /® o

CL S Informatton

[xX-] Properiies
R © e | % Do | ?
Search ... (use Esc to clear text) &|

\ = Properties (Superquadric1) B B

Center 0
Theta Roundness |1
Phi Roundness |1

Toroidal

|" = Disolav (GeometrvReoresentatic | ™ | i
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Creating a Cylinder Source

1. Go to the Sources menu and select Cylinder.
2. Click the [ & a0y | button to accept the default
parameters.
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Simple Camera Manipulation

e Drag left, middle, right buttons for rotate, pan, zoom.
o Laptop: use Shift, Ctrl modifiers (see Edit > Setting >
Camera)
e Also try holding down x, y, or z.

KXo XL L iy 2Bz @ D
BECGG
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Pipeline Object Properties

1. Go to the Source menu and select Cylinder.

2. Click the [ & a0y | button to accept the default
parameters.

3. Increase the Resolution parameter.

4. Resolution -]—
5. Click the |_& a0 | button again.

® |
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Pipeline Object Controls

(= Apply ) (@ Reset ) ( ¥ Delete )

" Sources
Filters
Readers
Extractors

~——

Pipeline objects —
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Display Properties

Properties
Apply ) Reset | 3 Delete ?
Search ... (use Esc to clear text) 3

Display(Geome @ @ & &

Representation Surface B
Coloring
'@ Solid Color &2 &
W Show || il Edit =~ Rescale

Styling
Opacity e [

Lighting
Specular ~ 0
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Change Display Properties

1. Scroll down to the Display group.

2. Click the QEI Edit Color Map button. (This button
is replicated in the toolbar.)

3. Select a new color for the cylinder.
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View Properties

Properties
Apply ) Reset 3¢ Delete ?
Search ... (use Esc to clear text) @,

= View(RenderV | @ @ & | &

Edit Axes Grid ...

| Center Axes Visibility

Orientation Axes

Orientation Axes Visibility

Background
Single color
‘ Color - Restore Default
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Change View Properties

1. Scroll down to the Display group.

2. Click the Qg Edit Color Map button. (This button is
replicated in the toolbar.)

3. Select a new color for the cylinder.

4. Scroll down to the View group.

5. Turn on the Axis Grid.
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Advanced Properties

e00 Properties
= Apply ) Reset | 3 Delete | 2 | T
- oggle
SGaI'Ch /ASearch ... (use Esc to clear text) } o e—— Advanced
Propertles Display (GeometryRe = | & | [ &l | Propertles
Representation | Surface s |
Coloring
| @ Solid Color :
W Show | ws Edit || %7 Rescale |
Styling
Opacity ) !1 I
Lighting
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Searching Properties

1. Type “specular” in the properties search box
2. Change Specular value to 1 (makes the cylinder
shiny)
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Searching Properties

1. Type “specular” in the properties search box
2. Change Specular value to 1 (makes the cylinder
shiny)

Other interesting properties:
* Axes Grid
« Opacity
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Changing the Color Palette

1. Make sure the orientation axes are visible in the
lower left corner. 4

2. Click the color palette button#*Zand change the
colors.

PP BE Lo F G KADDD G b

3. Try several color palettes.
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Undo Redo
S x
Undo Redo

Camera Camera
Undo Redo

& kitware




Reset ParaView

Edit — Reset Session

File m View Sources Filt

| Can't Undo #*Z N
3 Can't Redo 38R L

Camera Undo 3B
C,;l Camera Redo #F

Find Data... Vv
Change Input...

Copy

Paste

Ignore Time 4
Delete

Reset Session

S B _iia R
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=3 \

& kitware




Load disk_out_ref.ex2

1. Open the file disk_out_ref.ex2 from the
examples directory.

[ BN ] M Open File: (open multiple files with <ctrl> key.)
Look in: /Applications/ParaView-5.2.0-RC1.app/Contents/data/ E (] @ a‘
—F ¥ 21D |ES Filename
[ Home can.ex2
|| Desktop disk_out_ref.ex2
[ Documents headsq.vti

[ Downloads README .txt
[77] Macintosh HD

Files of type: = Supported Files (*.inp *.cosmo *.cgns *.cml *.csv '.t Cancel
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Load disk_out_ref.ex2

1. Open the file disk_out_ref.ex2 from the
examples directory.
2. Click [ & appy
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Display Properties

Reset Range Mapped Vector

Toggle Color Reset Scalar !
Variable Component Representation

Legie nd Range Over All Time

L

Edit Custom Scalar Scalar Range
Colors Range to Visible

. ‘ Magn‘i tude Surface ‘
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Representation
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Filters Menu

File Edit View Sources Iﬁﬂ Tools Catalyst Macros Help

@ @ @ @ @ Search... Ctrl+Space » DD Dﬂ @ Time: |0 9 m\ [Eq. 200 fl
, e ~ 1iters
&R Favorites > | Outline - x :05 Q 23 » ‘,33 »
- Alphabetical »
VBBB| >
Pipeline Project | Pipeline Annotation ’ Mlayout #1® | +
Pipeli‘ne Browser CTH ' e® | P E ® 30 &@ »RenderViewl 15
@ builtin: Chemistry » _
* Common 2 [ calculator .
Data Analysis »| @ Contour S tatus b ar °
Hyper Tree Grid »| @ clip
Material Analysis »| 10 slice . .
rointtnrérnelation +| @ Threshold ° S hort de SCr1 tl on
Quadrature Points » | @) Extract Subset p
Statistics »| © Glyph
Temporal » ° R h ° d
(%9 Group Datasets lk eas On y 1 S graye
Properties
@ %Delete | ?
|Se: (use E e@\
= Properties (Waveletl) | [3 || @ | b =1
Whole Extent |-10 |10
l-10 |10 [ .
~ v b Run Script |
Requires a point attribute array with 3 component(s)
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Common Filters

<:| Calculator

@ Contour
@ Clip
@ Slice
@ Threshold

Extract Subset
€ kitware

@ Glyph
@ Stream Tracer

=g Warp (vector)

Group Datasets

O Extract Block




Quick Launch

IType to search

[ 2D Glyph

2D Glyph

3D Text

AMR GaussianPulse Source
Adaptive Resample To Image
Add Field Arrays

Align Image Origins
Angular Periodic Filter
Animate Modes

Annotate Global Data
Annotate Selection
Annotate Time

Annotate Time Filter
Annend Attrihiitac

| @ Create a 2D glyph

Unavailable:

AMR Connectivity

AMR Contour

AMR Dual Clip

AMR Fragment Integration
AMR Fragments Filter
Aggregate Dataset
Annotate Attribute Data
Append Arc Length
Append Datasets
Append Geometry
Append Molecule
Append Reduce

Press Enter to create, Shift+Enter to create and apply.
Esc to cancel

Filter for annotating selection
-

@Used for searching
for filters by name
@Keyboard shortcut

e Ctrl-space for
Windows & Linux

e Alt-space for Mac




Apply Contour

1. Select disk_out_ref.ex2 in the pipeline browser.
Press the contour filter.

Kitware ParaView 3.5.0 (development]
e K<l >I>M S Tmeo

2] @ c?@ ? IR ’\‘ : Lklota sl 0
. g-»«@"""s H;) ﬁsu MR LR 66 G
Specify the data you e
apply the filter on |

0.006788
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Apply Contour

3. Change parameters to create an isosurface at Temp
= 400K. —

Search...

= Properties (Contourl) 0
Contour
Change to Temp —emwors—=ms B
V! Compute Normals
Compute Gradients
__| Compute Scalars
Isosur faces
Value Range: [0.0804768, 0.184839]
J

Change to 400 ————0.132658146 DiieE
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Apply Contour

1. Select disk_out_ref.ex2 in the pipeline browser.

2. Select the contour filter.

3. Change parameters to create an isosurface at Temp
= 400K.

4. | & Apply
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Apply ExtractSurface

1. Select disk_out_ref.ex2 in the pipeline browser.
2. From the quick launch, select Extract Surface.
3. | & Apply
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Apply ExtractSurface, Clip

1. Select disk_out_ref.ex2 in the pipeline browser.
2. From the quick launch, select Extract Surface.

3. | & Apply
4. Select ... @ Create a clip filter.

5. Uncheck [¥] show Plane
6. | & Apply
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Multiview

p® BR ? &AL ; B E KA > DB Tme o o
B @ 2 (orres W ( %) (Surface

M RdkLdis 666G

|
@
a
a
@
©
i
'Y
®

Pipclne Browser
builtin:
® @ disk_out_ref.ex2
@ @ Contourl
@ &@ ExtractSurfacel
@ @iipl

Object Inspector
———{(Properties | Display _Information

[oX~]

(& Apply

71 Show Plane
Origin 0 0 0.07999992
Normal 1 (] o

Camera Normal Center on Bounds

[inside Out




Multiview - Disk colored by Temp

Select disk_out_ref.ex2 in the pipeline browser.

Add Clip filter. ([
Uncheck [¥] show Plane

& Apply
Hide Clip2 @

a bk w0 np -~
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Multiview

1. Split the view horizontally. [
2. Make Clip2 visible. @
3. Color surface by Temp.
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Multiview

1. Split the view horizontally. [
2. Make Clip2 visible. @

3. Color surface by Temp.

4. Right-click view, Link Camera...
5. Click other view.
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Multiview

1. Split the view horizontally.
2. Make Clip1 visible. @

3. Color surface by Temp.

4. Right-click view, Link Camera...
5. Click other view.

6. Click ﬁ:’é and zoom in a bit.
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Modifying Views

a0, 800 S5
& BE ? i ® ®E K> B Tmeo o oY BT ? RRLNRNDY »E KA DS mmo o
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Posiin ower oo (5 < B ©0 2

8 buitin & buitin

= © disk_out refex2

o%ucﬂm r
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= [@cin
i

> @ disk out rtex2
@ @ Contow
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< maiz
R 00
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ClipTyoe (pine M Gl Type Crr—
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Conter o sounds
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Saving a DataSet [ﬂ

e Save Data saves the dataset output of the current active
plpellne ObJeCt - Save File: S < |

Look in: C:/Program Files/ParaView 5.2.0-Qt4-OpenGL2-Windows-64bit/ 0 © O i
File _> Sa ve Da ta I Examples Filename : Type Size Date Modified
L 4 & My Documents | bin Folder 06/01/2017 11:26:19
k. Desktop | data Folder 06/01/2017 11:27:05
. . & Favorites | doc Folder 06/01/2017 11:27:10
e Optionsto co Nnfi gure writer e N oo e ogyaon e
b DA | share Folder 06/01/2017 11:27:14

@ Windows Network|

File name: | | oK

Files of type: CSV File(*.csv ) “ Cancel

K kitware 5
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Saving a Screenshot ‘O

Il Save Screenshot Options ?

e Saves an image from the view st

o F I I e -> S a ve SC re e n S h O‘t Select resolution for the image to save
o Set ReSOIUtion and Quality Select image quxality (if applicable) “

0 - low quality, 100 - high quality
100
Override Color Palette
Current Palette

Stereo Mode (if applicable)

No Stereo

K kitware -
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Saving the State j\_,i

Save the current state of the application
File -> Save State
Include Pipeline, Views, Layouts, all properties...
PVSM State file : Robust, based on proxy state
e Descriptive Approach
e Enable user to modify file path
e Use with File -> Load State
e Use for sharing with colleagues
e Python State file : User-friendly, based on Ul actions
e Just a python script
e Use python shell or in pvpython

K kitware -




Reset ParaView

Edit — Reset Session

File m View Sources Filt

| Can't Undo #*Z N
3 Can't Redo 38R L

Camera Undo 3B
C,;l Camera Redo #F

Find Data... Vv
Change Input...

Copy

Paste

Ignore Time 4
Delete

Reset Session

S B _iia R
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Streamlines il

WY
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1.Open disk_out_ref.ex2. Load all variables.
2. Add Stream Tracer. |_& Ay
3.Change Seed Type to Point Source. ©=
4.Uncheck Show Sphere. [ show sphere

5. | & Apply
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Streamlines
1. Open disk_out_ref.ex2. Load all variables.
2. Add Stream Tracer. @
3. Change Seed Type to Point Source.
4. Uncheck Show Sphere. [ show sphere
5. | & Apply
6. From the quick launch, select Tube
7. & Apply

& kitware
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Adding Glyphs

Select StreamTracer1.

Add Glyph filter. @

Change Glyph Type to Cone.

Change Orientation Array and Scale Array to V.
Change Vector Scale Mode to Scale By Magnitude.
Click reset £¥ next to Scale Factor.

& Apply

8. Color by Temp.
& kitware
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Reset ParaView

Edit — Reset Session

File m View Sources Filt

| Can't Undo #*Z N
3 Can't Redo 38R L

Camera Undo 3B
C,;l Camera Redo #F

Find Data... Vv
Change Input...

Copy

Paste

Ignore Time 4
Delete

Reset Session

S B _iia R
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Volume Rendering

Open disk_out_ref.ex2. Load all variables. [ & amy
Change variable viewed to Temp.

Change representation to Volume.

In the Are you Sure dialog box, click Yes.

w0~
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Transfer Function Editor

@00 Color Map Editor

1ASearch...

[ | Interpret Values As Categories

Mapping Data

Data:

[ | Use log scale when mapping data to colors
[ | Enable opacity mapping for surfaces
MAutomatically rescale transfer functions to fit data

Color Mapping Parameters

Color Space | Diverging =)

Nan Color @ \

|v

// .
\\< |<I twa re ( Save as default [ & Update | & |
pE—




Modify Transfer Function

Select disk_out_ref.ex2.

Click Edit Color Map%.

Click Choose preset [ .

Select Black-Body Radiation. Apply. Close.
Try adding and changing control points.

a bk w0 np -~
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Reset ParaView

Edit — Reset Session

File m View Sources Filt

| Can't Undo #*Z N
3 Can't Redo 38R L

Camera Undo 3B
C,;l Camera Redo #F

Find Data... Vv
Change Input...

Copy

Paste

Ignore Time 4
Delete

Reset Session

S B _iia R
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Query-Based and Brush Selection

Open can.ex2. Select all variables. | & 4l
Go to last time step. pf e ——

e 99 s
i & 2 (@ms ) ( Surface %) @:dggg;;‘gﬁgglpl@‘ e

Top combo box: Find Cells. e

Next row: EQPS, is >=,and 1.5. =
Click Run Selection Query. |

A

(((((((((((((((((((((((((((((((

:/A\ Surface Cell Selection / Interactively Select Cells A7 Hover Cell Query

& kitware
A



Visualizing Large

Models
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Data Parallel Pipelines

@ Duplicate pipelines run independently on different
partitions of data.
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Data Parallel Pipelines

e Many operations will work regardless.
e Example: Clipping.
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Data Parallel Pipelines

e Many operations will work regardless.
e Example: Clipping
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Data Parallel Pipelines

e Many operations will work regardless.
e Example: Clipping
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Data Server

Control,
Display and Rendering
of Small Data

Depth Composite

N component Data

Parallelism for X GByte “ ' % ,

— .
Reader — Reader Q
¥xwe VP ¥ x/Ncs
Filter Filter
¥ ¥
Filter Filter
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ParaView’'s Running Modes

Builtin aka
Standalone aka
Serial

all components within one process (client may be
GUI or pvpython)

paraview or pvpython

Combined Server

data processing and parallel rendering in MPI job of
combined processes. control from TCP connected
client.

mpiexec -n x pvserver &; paraview # or
pvpython # + Connect

Batch

L L | Client
oo rs ] Sient
T | I\ \

DS | RS

server is an MPI job which directly runs a python

script
mpiexec -n x pvbatch \
vis script.py

DS = data server
RS = render server
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Start the ParaView Server from the Client

Prerequisites:
® Able to use ssh to connect to the server machine
Have a project allocation

o
@ Check paraview versions on server: see documentation
e Use client with the same major.minor version (5.13)

& kitware



https://docs.alcf.anl.gov/polaris/visualization/paraview/

4
File > Connect > Fetch Servers

S S S — e e e ey

JH Fetch Server Configurations x |

Configuration Name Server Source =
POLARIS@ANL Kitware Inc.
Kitware Inc. ‘
EDISON@NERSC Kitware Inc.
windows to EDISON@NERSC Kitware Inc.
CORI@NERSC Kitware Inc.
LANL VLGate: Gadget (UNIX) Kitware Inc.
LANL Turquoise: Lightshow (UNIX) Kitware Inc.
LANL Turquoise: Lightshow ... Kitware Inc.
LANL Turquoise: Moonlight (UNIX) Kitware Inc.
LANL Turquoise: Moonlight ... Kitware Inc.
NACA Nale~ £DLI i b
‘ Edit Sources ’

& kitware
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Connect Unix/Mac

Connection Options for "POLARIS@ANL" X

Xterm executable 7

SSH executable ssh

polaris.alcf.anl.gov

Remote machine

Username

ParaView version

Mac Os: Install Xquartz SN ot [t I
Server port 44995 =
Number of nodes to reserve @ |+ ‘

Number of ranks per node @ f

Number of minutes to reserv -
-

ATPiEVSC_Vlrhsfruc'tors

Account

Queue 'debug

File Systems home:eagle:grand
Job name paraview_server
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Connect Windows

M Connection Options for "windows to POLARIS@ANL"

] uotes are required
I SSH executable @ram Flles\Pump@{ q q

Remote machine poIarls alcf.anl.gov

Username danlipsa

ParaView version 5.13.1-EGL

Client port 11111 2
Server port 2181 ;
Windows: Install PUTTY © =
Number of nodes to reserve 2 v |
Number of ranks per node C 1) C}
Number of minutes to reserv@ ;C:i

) Account @ESC_Instructoh ’
Queue Zdebug }
File Systems home:eagle:grand ’
Job name :paraview_server \
OK \ Cancel \‘
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Advanced Data Parallel Pipelines

e Some operations will have problems.
e Example: External Faces

ESESES
SEESE:
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Advanced Data Parallel Pipelines

® Ghost cells can solve most of these problems.
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Balanced Partitioning + Ghost Cells

e Automatic when reading structured data.

@ For unstructured data:

o Ghost Cells: creates ghost cells (if data is partitioned
on disk)
e D3: also creates a balanced partition.

Extract Surface
after D3

Extract Surface
without ghost
cells
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Topics for future

exploration

& kitware



Python Scripting
Tools > Start Trace
Build visualization pipeline with Ul

Tools > End Trace
Save Python script
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Common Data Analysis Filters

] Extract Selection
i

®. Plot Global Variables Over Time

A Plot Selection Over Time

@‘ Plot Over Line

>,< Probe Location

& kitware




@ @ Properties

% Delete ?

lsearch ... (use Esc to clear text) I Q@
== Properties (Calc = [ W
Attribute Type ° Point Data

Coordinate Results
Result Array Name Result

coordsX*iHat+coordsY*jHat

Clear | ( ) iHat jHat k kHat
sin cos tan abs sqrt +
asin | acos atan ceil floor 2
sinh cosh tanh XAy exp 2
viv2 | mag norm In log10 /

Scalars B Vectors B

Calculator

& kitware

Properties
'Apply 2 3 Delete
Search Esc to clear text)

Properties (PythonCalculatorl) (3 @
Expression
Array Association | point Data

Array Name result

v | Copy Arrays

Python Calculator
(numpy)

"~y

User Defined Filters

(G]E

(] @ Ml Properties

'E?‘ [N @ Reset

3 Delete

N

Search ... (use Esc to clear text)

= Properties (Prog @

Output Data Set Same as Input
Type

Script

# get the first input
input® = inputs[0]

# compute an attribute
data = input@.PointData["V"] / 2.0
output.PointData.append(data, "V_half")

Copy Arrays

Programmable Filter
Python Algorithms

Plugins



Animation

[ Layout #1 @ 7 +

® Temporal data R ——

@ Fly over your data ‘

@ Animate filter
parameters

0\
1)
2,
3.
4.

|

e VT
vikBlogColers

ZQ0EWe

Animation View ®
Mode: Snap To TimeSteps + Time: 0.00 v |15 |3 maxis 43 Stride 1

Time 0 0.00150004 0.00286666  0.00429999

+/ | TimeKeeper1 - Time

# v Clip1 - Clip Type - Offset |-10 -2|-2 10

ok Clipt  + ||Clip Type - Offset -
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Advanced Rendering

@ Physically Based

Rendering (PBR)

@ Ray Tracing (Intel
OSPRay, Nvidia
OptiX)

& kitware




Questions
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paraview_server.e5691594
Permission denied
(publickey,keyboard-interactive,hostbased).

® ¢generate keys with the ssh-keygen command
@ navigate to ~/.ssh

® cp id_rsa.pub authorized_keys
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